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M2140 User's Guide
Welcome to the M2140 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics
See these sections to learn about the basic features of your product.
Using the Control Panel
Product Parts Locations
Checking for Software Updates
Using Power Saving Settings

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.
Control Panel Buttons and Lights
Changing LCD Screen Language
Parent topic: Product Basics

Control Panel Buttons and Lights

1 power button and light
2 LCD screen
3 help button
4 Arrow buttons and OK button
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5 stop button
6 start button
7 reset button
8 back button
9 home button

Parent topic: Using the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings and press the OK button.

You see this screen:

3. Select Printer Setup and press the OK button.
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You see this screen:

4. Select Language and press the OK button.
5. Select a language and press the OK button.
6. Press the home button to exit.
Parent topic: Using the Control Panel

Product Parts Locations
See these sections to identify the parts on your product.
Product Parts - Front
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics



13

Product Parts - Front

1 Control panel
2 Ink tank cover
3 Ink tank
4 Paper cassette cover
5 Front cover
6 Output tray

Parent topic: Product Parts Locations



14

Product Parts - Inside

1 Document cover
2 Scanner glass
3 Print head
4 Paper cassette edge guides
5 Paper cassette
6 Output selector
7 Printer cover

Parent topic: Product Parts Locations
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Product Parts - Back

1 Paper stopper
2 USB port
3 AC inlet
4 Rear paper feed slot
5 Rear cover
6 Maintenance box cover

Parent topic: Product Parts Locations

Checking for Software Updates
It's a good idea to check Epson's support website occasionally for free updates to your product software.
Visit epson.com.jm/support and select your product.
• Windows: Your printer software automatically checks for updates. You can also manually update the

software by selecting Software Update here:

• Accessing the Windows Desktop and right-clicking the icon for your product in the right side of
the Windows taskbar, or clicking the up arrow and right-clicking .

• On the Maintenance tab in the printer settings window

https://epson.com.jm/Support/sl/s
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You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

• OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

• macOS 10.12.x or 10.13.x: You can manually update the software by opening the App Store,
selecting Updates, searching for a software update option for Epson Software, and selecting Update.

• macOS 10.12.x, 10.13.x, or 10.14.x: You can manually update the software by opening the App
Store, selecting Updates, searching for a software update option for Epson Software, and selecting
Update.

Parent topic: Product Basics

Using Power Saving Settings
Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.
Changing the Sleep Timer Setting from the Control Panel
Changing the Power Off Timer Setting from the Control Panel
Parent topic: Product Basics

Changing the Sleep Timer Setting from the Control Panel
You can use the product's control panel to change the time period before the product enters sleep mode.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings and press the OK button.
3. Select Printer Setup and press the OK button.
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You see this screen:

4. Select Sleep Timer and press the OK button.
You see this screen:

5. Press the left or right arrow button to move the cursor and press the up or down arrow button to
adjust the number of minutes of inactivity before the product enters sleep mode. Then press the OK
button.

6. Press the home button to exit.
Parent topic: Using Power Saving Settings
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Changing the Power Off Timer Setting from the Control Panel
You can use the product's control panel to change the time period before the printer turns off
automatically.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings and press the OK button.
3. Select Printer Setup and press the OK button.

You see this screen:

4. Select Power Off Timer and press the OK button.
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You see this screen:

5. Select the length of time after which you want the product to automatically turn off when it is not in
use. Then press the OK button.

6. Press the home button to exit.
Parent topic: Using Power Saving Settings
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper in the Cassette
Loading Paper in the Rear Paper Feed
Paper Loading Capacity
Double-sided Printing Capacity
Compatible Epson Papers
Selecting the Paper Settings - Control Panel
Paper or Media Type Settings - Printing Software
Selecting the Default Paper Source Settings

Loading Paper in the Cassette
You can load paper up to this size in the paper cassette: Legal (8.5 × 14 inches [216 × 356 mm]).

Note: Before loading paper, make sure your product is not currently printing, scanning, or copying.

1. Open the paper cassette cover.
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2. Pull out the paper cassette until it stops.

Note: You cannot remove the paper cassette.

3. Slide the edge guides outward.
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4. Do one of the following:
• Insert paper into the cassette with the printable side facedown and slide it in until it stops.

Note: Make sure the paper is loaded against the rear of the cassette.

• For legal-size paper, load paper using the guide line as shown.
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• For 8.5 × 13 inches (216 × 330 mm) paper, load paper using the guide line as shown.

• Insert up to 10 envelopes with the printable side facedown and flap edge left, as shown.
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5. Slide the edge guides against the paper, but not too tightly.

Note: Make sure the paper fits under the tabs on the edge guides.

6. Slide the cassette back into the product until it stops.
7. Select the size and type of the paper you loaded on the product LCD screen and select OK. If your

paper size is not displayed, select User Defined.

Note: If you are printing on letterhead, select Letterhead as the paper type and make sure you
select the correct paper size setting.

8. Do one of the following:
• Close the paper cassette cover.
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• If you loaded envelopes, thick paper, or business cards, lower the output selector to eject paper to
the front of the printer and leave the paper cassette cover open.

Note: Do not remove or insert the paper cassette during printing.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first and printable side facedown.
• Make sure the paper fits under the tabs on the edge guides and does not stick out from the rear of

the cassette.
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load

one envelope at a time.
• If print quality declines when printing multiple envelopes, try loading one envelope at a time.
• Load letterhead or pre-printed paper top edge first.
• Check the paper package for any additional loading instructions.

Parent topic: Loading Paper
Related references
Paper Loading Capacity

Loading Paper in the Rear Paper Feed
You can print documents on a variety of paper types and sizes from the rear paper feed.
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1. Slide the edge guides out all the way.

2. Do one of the following:
• Insert one sheet of paper printable side up and short edge first, at the center of the rear paper feed

slot.

• Load one envelope in the center of the rear paper feed slot. Load it printable side up and flap edge
left.
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• Load one sheet of loose-leaf or other paper with holes facing as shown. You can load one sheet at
a time in only these sizes: Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches
[210 × 297 mm]), or Legal (8.5 × 14 inches [216 × 356 mm]).

3. Slide the edge guides against the paper, but not too tightly.

4. If you loaded envelopes or thick paper, open the paper cassette cover, lower the output selector to
eject paper to the front of the printer, and leave the paper cassette cover open.
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5. Select Settings > Printer Setup > Paper Source Settings > Paper Setting to select the size and
type of paper you loaded. If your paper size is not displayed, select User Defined.

Always follow these paper loading guidelines:
• Load only one sheet or envelope at a time.
• Load paper short edge first and printable side up.
• Load letterhead or pre-printed paper top edge first.
• If you have trouble loading an envelope, press it flat before loading it.
• Do not load an envelope that is curled, folded, or too thin, or that has a plastic window.
• Check the paper package for any additional loading instructions.
Parent topic: Loading Paper
Related references
Paper Loading Capacity
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Paper Loading Capacity
Paper type Loading capacity

Rear paper feed Cassette
Plain paper
Copy paper

1 sheet Letter (8.5 × 11 inches
[216 × 279 mm]) or A4 (8.3 × 11.7
inches [210 × 297 mm]) size or
smaller: 250 sheets
Legal (8.5 × 14 inches
[216 × 356 mm]) size: 1 sheet

Epson Bright White Paper 200 sheets
Epson Presentation Paper Matte
Epson High Quality Ink Jet Paper

100 sheets

Epson Premium Presentation
Paper Matte

20 sheets

Epson Premium Presentation
Paper Matte Double-sided

1 sheet

Thick paper
(25 to 68 lb [91 to 256 g/m²])

Letter (8.5 × 11 inches
[216 × 279 mm]), A4 (8.3 × 11.7
inches [210 × 297 mm]), or Legal
(8.5 × 14 inches [216 × 356 mm]): 1
sheet
User defined (4.1 × 5.8 inches [105 ×
148 mm] to 11.7 × 17 inches [297 ×
431.8 mm]): 1 sheet

Envelopes 10 envelopes

Parent topic: Loading Paper

Double-sided Printing Capacity
You can print double-sided on the paper types and sizes listed here.
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Paper type Size Double-sided printing capacity
Paper cassette Rear paper feed

slot
Plain paper
Copy paper

Letter (8.5 × 11 inches
[216 × 279 mm]) or A4
(8.3 × 11.7 inches
[210 × 297 mm]) or smaller

250 sheets 1 sheet

Legal (8.5 × 14 inches
[216 × 356 mm])

1 sheet

Epson Bright White
Paper

Letter (8.5 × 11 inches
[216 × 279 mm])

120 sheets

Epson Premium
Presentation Paper
Matte Double-sided

Letter (8.5 × 11 inches
[216 × 279 mm])

—

You cannot print double-sided on the following paper types:
• Epson High Quality Ink Jet Paper
• Epson Presentation Paper Matte
• Epson Premium Presentation Paper Matte
• Envelopes
Parent topic: Loading Paper

Compatible Epson Papers
You can purchase genuine Epson ink, maintenance boxes, and paper from an Epson authorized
reseller. To find the nearest reseller, visit epson.com.jm or call your nearest Epson sales office.

Note: Paper/media availability varies by country.

Paper Type Size Part number Sheet count
Epson Bright White Paper Letter (8.5 × 11 inches

[216 × 279 mm])
S041586 500

Epson High Quality Ink Jet Paper Letter (8.5 × 11 inches
[216 × 279 mm])

S041111 100

https://epson.com.jm
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Paper Type Size Part number Sheet count
Epson Presentation Paper Matte Letter (8.5 × 11 inches

[216 × 279 mm])
S041062 100

Legal (8.5 × 14 inches
[216 × 356 mm])

S041067 100

Epson Premium Presentation
Paper Matte

8 × 10 inches (203 × 254 mm) S041467 50
Letter (8.5 × 11 inches
[216 × 279 mm])

S041257 50

Epson Premium Presentation
Paper Matte Double-sided

Letter (8.5 × 11 inches
[216 × 279 mm])

S041568 50

Parent topic: Loading Paper

Selecting the Paper Settings - Control Panel
You can change the default paper size and paper type using the control panel on the product.

Note: These settings appear automatically when paper is inserted if you set the Paper Setup Auto
Display setting to On.

1. Press the home button, if necessary.
2. Select Settings > Printer Setup > Paper Source Settings > Paper Setting.

You see a screen like this:
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3. Select Paper Size.
4. Select the paper size you loaded.
5. Select Paper Type.
6. Select the paper type you loaded.
7. Select the home button to exit.
Paper or Media Type Settings - Control Panel
Parent topic: Loading Paper

Paper or Media Type Settings - Control Panel

For this paper Select this Paper Type setting
Plain paper
Epson Bright White Paper

Plain Paper

Epson High Quality Ink Jet Paper Hi-Quality Plain Paper
Epson Presentation Paper Matte Presentation Matte

Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-
sided

Prem. Matte

Envelope Envelope

Parent topic: Selecting the Paper Settings - Control Panel

Paper or Media Type Settings - Printing Software
For this paper Select this paper Type or Media Type setting
Plain paper
Epson Bright White Paper

Plain Paper / Bright White Paper

Envelopes Envelope
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For this paper Select this paper Type or Media Type setting
Epson Presentation Paper Matte
Epson Premium Presentation Paper Matte
Epson High Quality Ink Jet Paper
Epson Premium Presentation Paper Matte Double-
sided

Premium Presentation Paper Matte

Thick paper 25 to 68 lb (91 to 256 g/m²) Thick Paper

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper

Selecting the Default Paper Source Settings
You can change default paper source settings using the control panel on the product.
1. Press the home button, if necessary.
2. Select Settings > Printer Setup.

You see a screen like this:
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3. Select Auto Error Solver and select one of these options:
• Turn on this setting to display a warning and print single-sided when a 2-sided printing error

occurs, or to print only what the printer could process when a memory full error occurs.
• Turn off this setting to display an error message and stop printing if an error occurs.

4. Select the Paper Source Settings options you want to use.
5. When you are finished, press the home button to exit.
Paper Source Settings Options
Parent topic: Loading Paper

Paper Source Settings Options
Select the paper source options you want to use for your print jobs.

Paper Source
Settings option

Available settings Description

Paper Setting Various Select the paper size and type for each paper source
A4/Letter Auto
Switching

On Select On to switch the selected paper size to match the
loaded paper (Letter or A4) if the wrong size is selectedOff

Error Notice Paper Size Notice Select On for either of these settings to display an error
message when the selected paper type or size does not
match the loaded paperPaper Type Notice

Paper Setup
Auto Display

On Select On to automatically display a menu that lets you
select the paper size and type when you load paper in the
product.Off

Parent topic: Selecting the Default Paper Source Settings
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Placing Originals on the Product
Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damaging it.

Placing Originals on the Scanner Glass

Placing Originals on the Scanner Glass
You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or
A4 (8.3 × 11.7 inches [210 × 297 mm]).
1. Open the document cover.



36

2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the
original to the edges of the indicated corner.

Note: The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the
scanner glass. Manually position your original away from the edges to prevent cropping.

3. Close the document cover gently to keep your original in place.

Caution: Do not push down on the document cover or scanner glass or you may damage the
product.

Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
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Copying
See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying Options

Copying Documents or Photos
You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.
1. Place your original document or photo on the scanner glass.
2. Load the paper you want to print on in the product.
3. Press the home button, if necessary.
4. Press the left or right arrow button to select Copy and press the OK button.

You see this screen:

5. To print more than one copy, press the up or down arrow button to select the number (up to 99).
6. Press the left or right arrow button to enable or disable ID Card Copy. You can copy both sides of an

ID card onto one side of a sheet of paper.
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7. Press the OK button to view the print settings for the copies.
You see this screen:

8. Press the down arrow button to view the individual settings.
You see this screen:

9. To change the print settings, press the left or right arrow button and select the necessary settings.
When you are finished, press the OK button.
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10. When you are ready to copy, press the start button.

Note: To cancel copying, press the stop button.

Parent topic: Copying
Related topics
Loading Paper

Copying Options
Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Print Settings

Copying option Available settings Description
2-Sided 1>1-Sided Select to make 2-sided copies. When you select 1>2-Sided,

also select the orientation and binding edge for your
originals or copies.1>2-Sided

Density Varying levels Adjusts the lightness or darkness of copies
Paper Size Various settings Selects the paper size
Paper Type Various settings Selects the paper type
Paper Setting Paper Cassette

Rear Paper Feed
Slot

Selects the paper source

Reduce/Enlarge Actual Size Copies the original at its full size
Auto Fit Automatically sizes the image to fit the paper size you

selected
Custom 100% and
other conversions

Displays the amount to re-size the original. Change the
amount by adjusting the Custom Size setting.

Custom Size 25 - 400 in 1%
increments

Adjusts the amount to re-size the original.

Original Size Various sizes Select the document size of your original



40

Copying option Available settings Description
Multi-Page Single Page Copies each page of the original onto an individual sheet

2-up Copies multiple page documents onto one sheet. Scroll
down and select the document orientation and layout order
settings as necessary.

Original Type Text Specifies the document type of your originals and adjusts
the quality of your copiesText & Image

Photo
Text & Image (Best)

Parent topic: Copying
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Printing from a Computer
Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Cancelling Printing Using a Product Button

Printing with Windows
You can print with your product using any Windows application, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document - Windows
Locking Printer Settings - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing from a Computer
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Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:
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4. For the Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. To print on both sides of the paper, select a 2-Sided Printing option.
10. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select

one of the settings in the Multi-Page menu and select the printing options you want.
11. To print multiple copies and arrange their print order, select the Copies options.
12. To preview your job before printing, select Print Preview.
13. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
14. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the

Quiet Mode menu.

Note: Enabling Quiet Mode may reduce printing speed.

Print Quality Options - Windows
Multi-Page Printing Options - Windows
Parent topic: Printing with Windows
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Double-sided Printing Settings - Windows
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Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on plain paper.
Standard

For everyday text and image printing.
High

For photos and graphics with high print quality.
More Settings

Opens a window that lets you choose among levels of speed and quality.
Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.
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1. Select one of the following options for 2-Sided Printing:
• Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper

on the long edge.
• Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper

on the short edge.
• Manual (Long-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the long edge to print the other side (recommended for
paper types that do not support automatic duplexing).

• Manual (Short-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the short edge to print the other side (recommended for
paper types that do not support automatic duplexing).

2. Click the Settings button.
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You see this window:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
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5. Click the Print Density button.
You see this window:

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.
8. Click OK to return to the Main tab.
9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options - Windows
Print Density Adjustments - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows
You can select any of the available options on the Binding Settings window to set up your double-sided
print job.
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Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.
Print Density

Sets the level of ink coverage for double-sided printing.
Increase Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your

document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Tone Correction options:
• Select Automatic to automatically adjust the brightness and contrast for your image.
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• Select Custom and click the Advanced button to manually adjust the tone correction settings or
turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:

• Anti-Copy Pattern: adds a watermark that only appears when your printout is copied

Note: This setting is not available for all types of printing.

• Watermark: adds a visible watermark to your printout

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.
Custom Tone Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
Parent topic: Printing with Windows
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Custom Tone Correction Options - Windows
You can select any of the available options in the Tone Correction window to customize the image tone
for your print job.

Gamma
Adjusts the midtone density of the image.

Brightness
Adjusts the overall lightness and darkness of the image.

Contrast
Adjusts the difference between the light and dark areas of the overall image.
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Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options
Emphasize Text

Adjusts the weight of printed text to increase readability.
Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Emphasize Light Text and Lines

Adjusts the weight of light text and printed lines to increase visibility.

Additional Settings Options
Rotate 180º

Prints the image rotated 180º from its original orientation.
High Speed

Speeds up printing but may reduce print quality.
Mirror Image

Flips the printed image left to right.
Parent topic: Selecting Additional Layout and Print Options - Windows

Header/Footer Settings - Windows
You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.
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Note: These settings are not saved with your document.

You can select to print the following information:
• User Name
• Computer Name
• Date
• Date/Time
• Document Name
• Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

2. Place your cursor over one of the Printing Presets to view its list of settings.
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3. Click on a preset to change its settings, or use any of the available options on the screen to control
your printing presets.

4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.

You see the maintenance options:
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4. Click the Extended Settings button.
You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows

Extended Settings - Windows
You can select from these settings on the Extended Settings window.
Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Short Grain Paper

Prevents ink from smearing when you print on envelopes or other thick paper.
Separator Page

Before each document, prints a separator page containing the title, user, date, and time.
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Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,
preprinted paper, envelopes, and thick paper.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

2. Click OK or Print to start printing.
Parent topic: Printing with Windows

Locking Printer Settings - Windows
Windows administrators can lock access to some printer settings to prevent unauthorized changes.
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product and select Printer properties.

• Windows 7: Click and select Devices and Printers. Right-click your product and select
Printer properties.
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• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product and select Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group
permissions in the Security tab.

3. Click Driver Settings.
You see this window:

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Locked Setting Options
Parent topic: Printing with Windows
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Locked Setting Options
Select the options you want to use for any locked print settings.

Setting Options Description
Anti-Copy
Pattern

Various data items Lets you select the data to use for the pattern or prohibit anti-
copy patterns

Add/Delete Lets you add or delete a customized anti-copy pattern
Settings Lets you select the arrangement, size, and other settings for

the custom anti-copy pattern
Watermark Various text

watermarks
Lets you select the text for the watermark or prohibit
watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, and other watermark
settings

Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and

footers
2-sided printing Off Allows printing on one side of the paper only

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
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1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
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1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
You see the printer settings window.

3. Click the Maintenance tab.
You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Related tasks
Checking for Software Updates



64

Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product. To print with additional settings, download and install the Epson Print and Scan utility from the
Windows Store. You cannot download and install any Epson product software from the Epson website
for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.



65

You see a window like this:

4. Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

5. Click the Advanced button.
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You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.
7. To print multiple copies, select or enter the number as the Copy Count setting.
8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.
9. Click OK.

You return to the printing preferences window.
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10. Select the Layout tab.

11. Select the orientation of your document as the Orientation setting.
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12. To print double-sided, select one of the Print on Both Sides options, depending on how you want to
orient the page layout. The icon next to each option shows the layout.

13. Click OK to save your settings.
You see your application's Print window.

14. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S

Printing on a Mac
You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
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Selecting Print Layout Options - Mac
Selecting Double-sided Printing Settings - Mac
Selecting Printing Preferences - Mac
Printing Your Document - Mac
Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings or Printer Features from the pop-up menu.
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You see these settings:

Note: The available print settings and appearance of the print window may be different than those
covered here, depending on the Mac OS version and the application you are using.

9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.
Print Quality Options - Mac
Print Options - Mac
Parent topic: Printing on a Mac
Related tasks
Printing Your Document - Mac
Selecting Page Setup Settings - Mac
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Print Quality Options - Mac
You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.
Draft

For draft printing on plain paper.
Normal

For everyday text and image printing.
Quality

For text and graphics with increased quality and print speed.
Best Quality

For the best print quality, but the slowest print speed.
Parent topic: Selecting Basic Print Settings - Mac

Print Options - Mac
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Mirror Image

Lets you flip the printed image horizontally.
Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.
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1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac

Selecting Print Layout Options - Mac
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To print on both sides of each page, select a setting from the Two-Sided pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
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Parent topic: Printing on a Mac

Selecting Double-sided Printing Settings - Mac
You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the Mac
OS version you are using.

1. Select one of the Two-sided Printing options.
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2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options and Adjustments - Mac
Parent topic: Printing on a Mac

Double-sided Printing Options and Adjustments - Mac
You can select any of the available options in the Two-sided Printing Settings pop-up menu to set up
your double-sided print job.
Long-Edge binding

Orients double-sided printed pages to be bound on the long edge of the paper.
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Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac

Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.

You see a screen like this:
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4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac
Parent topic: Printing on a Mac

Printing Preferences - Mac
You can select from these settings on the Options or Driver tab.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
Quiet Mode

Lessens noise during printing but may decrease print speed.
High Speed Printing

Speeds up printing but may reduce print quality.
Warning Notifications

Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document - Mac
Once you have selected your print settings, you are ready to print.
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Click Print at the bottom of the print window.

Checking Print Status - Mac
Parent topic: Printing on a Mac
Related tasks
Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
Selecting Print Layout Options - Mac
Selecting Double-sided Printing Settings - Mac
Selecting Printing Preferences - Mac

Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

2. Select the following options as necessary for your Mac OS version:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document - Mac

Cancelling Printing Using a Product Button
If you need to cancel printing, press the stop button on your product.
Parent topic: Printing from a Computer
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Scanning
You can scan your originals and save them as digital files.
Starting a Scan
Scanning in Epson Scan 2

Starting a Scan
After placing your originals on your product for scanning, start scanning using one of these methods.
Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Parent topic: Scanning
Related tasks
Placing Originals on the Scanner Glass

Starting a Scan Using the Product Control Panel
You can scan an image to your computer using your product's control panel buttons.
Your product automatically selects default scan settings, but you can view or change them as necessary.
When scanning to a memory card, you can change the scan settings using the product's LCD screen. If
you are scanning to a computer, you can change the default scan settings using the Event Manager
utility on the computer.
1. Make sure you installed the product software and connected the product to your computer or

network.

Note: Restart your computer after installing the product software to enable scanning from the control
panel. Also make sure the Event Manager program is not being blocked by your firewall or security
software.

2. Press the home button, if necessary.
3. Press the left or right arrow button to select Scan and press the OK button.
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You see a screen like this:

4. Press the left or right arrow button to select a scan option and press the OK button.
• To Computer (JPEG) saves your scan as a JPEG file on your computer or as an image capture

on a Mac.
• To Computer (PDF) saves your scan as a PDF file on your computer or as an image capture on a

Mac.
• To Computer (Email) scans your original and attaches it to a message in your e-mail program.

You can select the e-mail program you want to use and resize your image, if necessary, from an
option screen on your computer.

Note: This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail,
and Entourage, but not web-based email such as Gmail.

• To Computer (Custom) saves your scan using custom settings you have selected with the Event
Manager custom scan settings option.

5. Press the start button to start scanning.
Changing Default Scan Job Settings
Parent topic: Starting a Scan

Changing Default Scan Job Settings
You can view or change the default scan job settings your product uses when you scan to your
computer. You do this using the Event Manager program.
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1. Do one of the following to open Event Manager:

• Windows 10: Click and select EPSON Software > Event Manager.
• Windows 8.x: Navigate to the Apps screen and select Event Manager.

• Windows (other versions): Click or Start > All Programs or Programs > EPSON Software
> Event Manager.

• Mac: Open the Applications folder, click Epson Software, and select Event Manager.
2. Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if

necessary.
3. Click Make Job Settings.
4. Open the Edit Job Settings drop-down list and select the scan job settings you want to view or

change.
5. Change the settings as necessary.
6. Click OK.
7. Click Close to close the Event Manager window.
Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using the Epson Scan 2 Icon
You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

• Windows 10: Click and select EPSON > Epson Scan 2.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program
You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Scanning in Epson Scan 2
Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Start Epson Scan 2.
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You see this window:
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2. Select the Document Source setting that matches where you placed your original.
3. Select the Document Size setting that matches the size of your original. You can select Customize

to enter a custom size, if necessary.
4. Select the image type of your original and how you want it scanned as the Image Type setting.
5. Select the Resolution setting you want to use for your scan.
6. Click the Preview button.

Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

7. Select any of the additional settings that you want to use on the Main Settings tab.
8. Click the Advanced Settings tab and select any settings that you want to use.
9. Select the format in which you want to save your scanned file as the Image Format setting. If

necessary, select Options and select any desired format options.
10. Enter the file name for your scanned file in the File Name field. If necessary, select Settings to

modify the file name settings.
11. Select the location in which you want to save your scanned file as the Folder setting. If necessary,

select Select to create a new folder.
12. Click Scan.
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The product scans your original and saves the scanned file in the location you specified.
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Image Format Options
Scan Resolution Guidelines
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
Parent topic: Scanning

Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Correct Document Skew

Corrects skewed originals, image contents, or both.
Add or edit pages after scanning

Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Advanced Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Remove Background

Removes the background of the originals.
Text Enhancement

Sharpens the appearance of letters in text documents.
Auto Area Segmentation

Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.
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Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Parent topic: Scanning in Epson Scan 2

Image Format Options
You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.
BITMAP (*.bmp)

A standard image file format for most Windows programs.
JPEG (*.jpg)

An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.
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TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines
The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your
scans. Increasing the resolution raises the amount of detail captured but comes with the following
disadvantages:
• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the
resolution setting you need:
• You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same
amount you will increase the image size to retain a high image quality. For example, if the resolution is
300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600
dpi.

• You will scan the image at 100% or smaller size.
Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
• Email/view on a computer screen/post on the web: 96 to 200 dpi
• Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi
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Parent topic: Scanning in Epson Scan 2

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.
1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. Select Searchable PDF as the Image Format setting.
6. Select Options from the Image Format list.

You see this window:

7. Select any of the options on the General tab.
8. Select the Text tab.
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9. Make sure the language used in the document text is selected as the Text Language setting.
10. Select the Security tab if you want to add a password to the PDF or protect printing or editing

properties.
11. Click OK.
12. Confirm the File Name setting and select a Folder setting for your document.
13. Click Scan.

The scanned image is saved as a searchable PDF.
Parent topic: Scanning in Epson Scan 2
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Refilling Ink and Replacing the Maintenance Box
When the ink level is below the lowest line on the ink tank, you need to refill it. Periodically check the ink
tank to see if it needs to be refilled.
Before checking the ink level or refilling an ink tank as described here, be sure to read the ink safety
precautions.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank.
Continued use of the product when the ink level is below the lower line on a tank could damage the
product.

Ink Safety Precautions
Check Ink Level
Purchase Epson Ink
Refilling the Ink Tank
Maintenance Box Replacement

Ink Safety Precautions
Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tank correctly. The product cannot directly measure the ink level in the tank; instead it estimates
the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate
inaccurate messages if the ink tank is not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tank to ensure the ink level does not fall
below the lower line. Continued use of the product when the ink level is below the lower line on the tank
could damage the product.

Ink Handling Precautions
Observe the following when handling the ink:
• Keep ink bottles and the ink tank out of the reach of children. Do not allow children to drink from or

handle the ink bottles and bottle caps.
• Do not tilt or shake an ink bottle after removing its seal; otherwise, ink may leak.
• Be careful not to touch any ink when you handle the ink tank, ink tank cap, and opened ink bottles or

ink bottle caps.
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• If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them
immediately with water. If ink gets into your mouth, spit it out immediately. Seek medical advice if
problems persist.

Ink Refilling Precautions
• Use ink bottles with the correct part number for this product.
• The use of non-Epson ink may cause damage that is not covered by Epson’s warranty, and under

certain circumstances, may cause erratic product behavior.
• This product requires careful handling of ink. Ink may splatter when the ink tank is filled or refilled with

ink. If ink gets on your clothes or belongings, it may not come off.
• Do not open the ink bottle package until you are ready to fill the ink tank. Ink bottles are vacuum

packed to maintain reliability. If you leave an ink bottle unpacked for a long time before using it, print
quality may be affected.

• If the ink level is below the lower line on the ink tank, refill the ink soon. Continued use of the product
when the ink level is below the lower line on the ink tank could damage the product.

• Epson recommends filling the ink tank to the upper line when the product is not operating.
• After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for

at least three hours before using it.
• Store ink bottles in a cool, dark place.
• Store the ink bottles in the same environment as the product. When storing or transporting an ink

bottle after removing its seal, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to
keep the ink bottle upright when tightening the cap, and take measures to prevent ink from leaking
when you transport the bottle.

• Use the ink bottle before the date printed on the package.
• Do not shake or squeeze the ink bottle.

Ink Bottle and Ink Tank Information
• To maintain optimum print head performance, some ink is consumed from the ink tank during printing

and when performing maintenance operations, such as cleaning the print head.
• The ink bottles may contain recycled materials, but this does not affect product function or

performance.
Parent topic: Refilling Ink and Replacing the Maintenance Box
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Check Ink Level
Your product and its printing software will let you know when the ink tank is low or expended.
Checking the Ink Level on Your Product
Checking Ink and Maintenance Box Levels - Windows
Checking Ink and Maintenance Box Levels - Mac
Disabling Special Offers with Windows
Parent topic: Refilling Ink and Replacing the Maintenance Box

Checking the Ink Level on Your Product
To confirm the actual ink level, visually check the ink level in the product’s ink tank. Make sure the ink
level is above the lower line on the ink tank.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tank correctly. The product cannot directly measure the ink level in the tank; instead it estimates
the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate
inaccurate messages if the ink tank is not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tank to ensure the ink level does not fall
below the lower line. Continued use of the product when the ink level is below the lower line on the tank
could damage the product.

Parent topic: Check Ink Level
Related tasks
Refilling the Ink Tank
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Checking Ink and Maintenance Box Levels - Windows
A low ink reminder appears if you try to print when ink is low, and you can check your ink level at any
time using a utility on your Windows computer.
1. To check your ink and maintenance box levels, access the Windows Desktop and double-click the

icon for your product in the right side of the Windows taskbar, or click the up arrow and double-
click .
You see a window like this:
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2. Refill the ink tank or replace the maintenance box as needed.

Note: The product has a low ink alert system. The accuracy of this system depends on the user
refilling the ink tank correctly. The product cannot directly measure the ink level in the tank; instead it
estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system
may generate inaccurate messages if the ink tank is not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tank to ensure the ink level does not
fall below the lower line. Continued use of the product when the ink level is below the lower line on
the tank could damage the product.

Parent topic: Check Ink Level
Related tasks
Refilling the Ink Tank

Checking Ink and Maintenance Box Levels - Mac
You can check your ink level using a utility on your Mac.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
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You see a window like this:

3. Refill the ink tank or replace the maintenance box as needed.

Note: To update or refresh the displayed ink level, click Update.

Note: The product has a low ink alert system. The accuracy of this system depends on the user
refilling the ink tank correctly. The product cannot directly measure the ink level in the tank; instead it
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estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system
may generate inaccurate messages if the ink tank is not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tank to ensure the ink level does not
fall below the lower line. Continued use of the product when the ink level is below the lower line on
the tank could damage the product.

Parent topic: Check Ink Level
Related tasks
Refilling the Ink Tank

Disabling Special Offers with Windows
You can disable special offers messages from Epson using a utility on your Windows computer.

Note: You may see the Epson Special Offers screen every time you print (if your computer is connected
to the Internet). Select Do not display this message again and click Decline to disable online offers.
Promotional offers are not valid in Latin America.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click . Select Monitoring Preferences.
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You see this window:

2. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Ink Level

Purchase Epson Ink
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest
reseller, visit epson.com.jm or call your nearest Epson sales office.

Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not
specified for this printer could cause damage not covered by Epson's warranties.
The ink bottle that is used for initial product setup has a lower yield due to the ink charging process. This
process is carried out the first time you turn on the printer and guarantees better performance. Yields

https://epson.com.jm
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vary considerably based on print jobs, print settings, paper type, frequency of use, and temperature. Do
not load paper before refilling the ink tank.
Check the ink level in your product frequently, and refill the ink tank if necessary.

Ink Bottle and Maintenance Box Part Numbers
Parent topic: Refilling Ink and Replacing the Maintenance Box

Ink Bottle and Maintenance Box Part Numbers
Use these part numbers when you order or purchase new ink bottles. Use the ink by the date printed on
the package.

Ink color Part number
Standard-capacity High-capacity

Black 534S* 534

*Ink availability varies by country.
Maintenance box part number: T04D100
Parent topic: Purchase Epson Ink

Refilling the Ink Tank
Make sure you have a new ink bottle handy and have read the ink safety precautions before you begin.
You can continue to use the product even if the ink tank is not filled all the way. However, for the most
accurate ink level monitoring, fill all the ink tank up to the upper line.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tank correctly. The product cannot directly measure the ink level in the tank; instead it estimates
the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate
inaccurate messages if the ink tank is not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tank to ensure the ink level does not fall
below the lower line. Continued use of the product when the ink level is below the lower line on the tank
could damage the product.

Caution: If ink spills, wipe it off immediately with a damp towel to avoid permanent stains. If ink gets on
your clothes or belongings, it may not come off.
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1. Turn on your product.
2. Press the home button, if necessary.
3. Select Maintenance and press the OK button.

You see this screen:

4. Select Reset Ink Level and press the OK button.
5. Open the ink tank cover, then open the ink tank cap.
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6. Hold the ink bottle upright and slowly turn the bottle cap to remove it.

Caution: Do not shake or squeeze the bottle. Do not touch the top of the bottle after its cap is
removed.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out immediately. Seek medical
advice if problems persist. Keep the ink bottles out of the reach of children and do not drink the ink.
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7. Position the top of the ink bottle along the slot in front of the filling port, then slowly stand the bottle
up to insert it.

8. Wait for the ink to fill the tank. Do not squeeze the bottle. Ink flows into the tank and stops
automatically when the ink is filled to the upper line.
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Note: If ink does not flow from the bottle, lift and reinsert the bottle.

9. When the ink tank is full, remove the ink bottle and securely close the ink tank cap.

Note: If any ink remains in the bottle, replace the bottle cap and tighten it. Store the bottle upright for
later use.

10. Close the ink tank cover.

11. Press the start button.
12. Press the start button again to reset the ink level.

Caution: If you reset the ink level without refilling the ink tank to the upper line, you may print without
enough ink in the tank and damage your printer. Before you print, make sure you visually check the
ink level of the tank.
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Parent topic: Refilling Ink and Replacing the Maintenance Box
Related concepts
Purchase Epson Ink

Maintenance Box Replacement
The maintenance box stores surplus ink that gets collected during printing or print head cleaning. When
you see a message on the LCD screen, follow the on-screen instructions to replace the maintenance
box.

Note: When the maintenance box is full, you cannot print or clean the print head until it is replaced.
However, you can perform operations that do not require ink, such as scanning.

Note the following precautions when replacing the maintenance box:
• Do not remove the maintenance box or its cover except when replacing the maintenance box;

otherwise, ink may leak.
• Do not touch the green chip on the side of the maintenance box.
• Do not tilt the maintenance box after removing it or ink may leak.
• Do not touch the openings in the maintenance box or you may get ink on you.
• Do not drop the maintenance box or subject it to strong shocks.
• If you cannot replace the cover, the maintenance box may not be installed correctly. Remove and

reinstall the maintenance box.
• Do not store the maintenance box in high or freezing temperatures.
• Do not replace the maintenance box during printing; otherwise, ink may leak.
• Keep the maintenance box out of direct sunlight.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for a long period.
Keep the maintenance box away from direct sunlight.

Note: The maintenance box is a user-replaceable part and is not covered by the product warranty.

Parent topic: Refilling Ink and Replacing the Maintenance Box
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to run a Power Cleaning or clean the
paper or print head path.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide
Cleaning the Print Head Path
Checking the Number of Sheets

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if the ink level has reached the lower line on the ink tank, and may
not be able to clean it when the ink level in the tank is low. You must refill the ink tank first.

If you still see white or dark lines or gaps in your printouts, even after cleaning the print head several
times, you can run a Power Cleaning.
Print Head Nozzle Check
Print Head Cleaning
Power Cleaning
Parent topic: Adjusting Print Quality
Related tasks
Refilling the Ink Tank

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility
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Parent topic: Print Head Maintenance
Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the paper cassette.
3. Press the home button, if necessary.
4. Select Maintenance and press the OK button.

You see this screen:

5. Press the OK button to select Nozzle Check.
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You see this screen:

6. Press the start button to print.
The nozzle check pattern is printed.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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Print head needs cleaning

8. Do one of the following:
• If there are no gaps, the print head is clean. Select No and press the OK button.
• If there are gaps or the pattern is faint, select Yes and press the OK button. Follow the instructions

on the screen to clean the print head.
Parent topic: Print Head Nozzle Check
Related concepts
Power Cleaning
Related tasks
Loading Paper in the Cassette
Refilling the Ink Tank
Cleaning the Print Head Using the Product Control Panel

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the paper cassette.
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3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
You see a window like this:

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
Related concepts
Power Cleaning
Related tasks
Loading Paper in the Cassette
Refilling the Ink Tank
Cleaning the Print Head Using a Computer Utility
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Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if the ink level has reached the lower line on the ink tank, and may
not be able to clean it when the ink level in the tank is low. You must refill the ink tank first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance

Cleaning the Print Head Using the Product Control Panel
You can clean the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the paper cassette.
3. Press the home button, if necessary.
4. Select Maintenance and press the OK button.
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5. Select Head Cleaning and press the OK button.

6. Press the start button to clean the print head. You see a message on the LCD screen during the
cleaning cycle.

Caution: Never turn off the product or open the printer cover during a cleaning cycle or you may not
be able to print.

When the cleaning cycle is finished, you see a message on the LCD screen.
7. Select Nozzle Check, press the OK button, and press the start button to run a nozzle check and

confirm that the print head is clean.
If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, run a Power
Cleaning. If there is still no improvement, contact Epson support.
Parent topic: Print Head Cleaning
Related concepts
Power Cleaning
Related references
Where to Get Help
Related tasks
Loading Paper in the Cassette
Checking the Nozzles Using the Product Control Panel
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Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the paper cassette.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
You see a window like this:

5. Click Start to begin the cleaning cycle.
The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.
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Caution: Never turn off the product or open the printer cover during a cleaning cycle or you may not
be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least six hours. Then try cleaning the print head again. If quality still does not improve, run a Power
Cleaning. If there is still no improvement, contact Epson support.
Parent topic: Print Head Cleaning
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Related concepts
Power Cleaning
Related references
Where to Get Help
Related tasks
Loading Paper in the Cassette

Power Cleaning
If you still see white or dark lines or missing nozzles in your printouts, even after cleaning the print head
several times, you can run a Power Cleaning.
If you do not see improvement after running a Power Cleaning, turn off the product and wait at least 12
hours before running another Power Cleaning.

Caution: Running a Power Cleaning consumes a lot of ink, so you should run it only if necessary. Make
sure the ink tank is at least one-third full before running a Power Cleaning, or it may damage the product.

Caution: Power Cleaning may cause the maintenance box to reach its capacity sooner. When the
maintenance box is full, you need to replace it to continue printing.

Power Cleaning Using the Product Control Panel
Power Cleaning Using a Computer Utility
Parent topic: Print Head Maintenance
Related tasks
Refilling the Ink Tank

Power Cleaning Using the Product Control Panel
You can run a Power Cleaning using the control panel on your product.

Note: After a Power Cleaning, you must turn off the product and wait at least 12 hours before running
another Power Cleaning.

1. Make sure there are no errors on the LCD screen.
2. Turn off the product.
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3. Visually check the ink level and make sure the ink tank is at least one-third full.

Caution: If you run a Power Cleaning when the ink level is low, you may damage the product.

4. Press and hold the power button and the help button at the same time until you see the Power
Cleaning screen.

5. Follow the instructions on the LCD screen to run the Power Cleaning.
6. When the Power Cleaning is finished, run a nozzle check.
If the print quality did not improve, turn off the product and wait at least 12 hours before running another
Power Cleaning.
If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson
for support.
Parent topic: Power Cleaning
Related tasks
Refilling the Ink Tank

Power Cleaning Using a Computer Utility
You can run a Power Cleaning using a utility on your Windows or Mac computer.

Note: After running a Power Cleaning, you must turn off the product and wait at least 12 hours before
running another Power Cleaning.

1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the cassette.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and
click the Maintenance tab.

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Power Cleaning.
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You see a window like this:

5. Follow the on-screen instructions to run a Power Cleaning.
6. When Power Cleaning is finished, run a nozzle check.
If the print quality did not improve, turn off the product and wait at least 12 hours before running another
Power Cleaning.
If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson
for support.
Parent topic: Power Cleaning
Related tasks
Refilling the Ink Tank
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Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Parent topic: Adjusting Print Quality

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the cassette.
3. Press the home button, if necessary.
4. Select Maintenance and press the OK button.

5. Select Print Head Alignment and press the OK button.
6. Do one of the following:

• Select Vertical Alignment and press the OK button.
• Select Horizontal Alignment and press the OK button.
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7. Press the OK button to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and select the number representing the most solid printed pattern for each
set on the LCD screen.
Vertical Alignment

Horizontal Alignment

9. Press the OK button when you are finished.
Parent topic: Print Head Alignment
Related tasks
Loading Paper in the Cassette

Cleaning the Paper Guide
If you see ink on the back of a printout or if printouts are smeared or scuffed, you can clean the paper
guide roller to remove any excess ink.
1. Make sure there are no errors on the LCD screen.
2. Load plain paper in the cassette in this size: Letter (8.5 × 11 inches [216 × 279 mm]) or A4

(8.3 × 11.7 inches [210 × 297 mm]).
3. Press the home button, if necessary.



124

4. Select Maintenance.
You see a screen like this:

5. Select Paper Guide Cleaning and press the OK button.
6. Follow the instructions on the LCD screen to clean the paper guide.
7. Repeat these steps as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
Related tasks
Loading Paper in the Cassette

Cleaning the Print Head Path
If the print quality has not improved after cleaning and aligning the print head and cleaning the paper
path, the print head path inside the printer may be smeared with ink.
To clean the print head path, use the following:
• Several cotton swabs
• ¼ cup (60 ml) water containing 2 to 3 drops of mild dish detergent
• A small flashlight

Caution: Do not use any other liquid to clean the print head path or you may damage your product.

1. Turn off the product.
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2. Unplug the power cable.
3. Disconnect any connected cables.
4. Open the printer cover.

5. Using the flashlight, check the translucent film shown here for ink smears.
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A Translucent film
B Print head rail

Caution: Do not touch the print head rail or wipe the grease off of it. You may not be able to print. Do
not touch the white flat cable or ink tubes.

6. Moisten a cotton swab with the water and detergent mixture, and squeeze out any excess moisture.
Lightly wipe the ink off the translucent film.

Caution: Do not press too hard on the film or you may dislocate the anchor springs and damage
your product.

7. Use a new, dry cotton swab to dry the translucent film.
8. Repeat steps 6 and 7 as necessary to clean all ink smears.
9. When the translucent film is dry, close the printer cover.
10. Reconnect any disconnected cables, plug in the power cord, and turn on the product.
Parent topic: Adjusting Print Quality
Related tasks
Cleaning the Paper Guide

Checking the Number of Sheets
You can view an option that displays the number of sheets of paper that have fed through the product.
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Note: You can also view the number of sheets of paper fed through the product by printing a nozzle
check.

Checking the Sheet Counter - Windows
Checking the Sheet Counter - Mac
Parent topic: Adjusting Print Quality

Checking the Sheet Counter - Windows
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.
4. Select Printer and Option Information.

You see this window:

5. After checking the number of sheets fed into the printer, click OK to close the window.

Note: The number of sheets is displayed only when Epson Status Monitor 3 is enabled.

Parent topic: Checking the Number of Sheets
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Checking the Sheet Counter - Mac
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select Printer and Option Information.
You see this window:

3. After checking the number of sheets fed into the printer, click OK to close the window.
Parent topic: Checking the Number of Sheets
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Cleaning and Transporting Your Product
See these sections if you need to clean or transport your product.
Cleaning Your Product
Cleaning the Paper Rollers
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.
Close the front cover and paper cassette cover when you are not using the product to protect it from
dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a

little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.

6. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product

Cleaning the Paper Rollers
If you encounter repeated paper feed issues from the cassette, clean the paper rollers inside the
product.
1. Turn off the product.
2. Unplug the power cable.
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3. Disconnect any connected cables.
4. Slide out the paper cassette and remove the paper.

5. Make sure the ink tank cap is securely closed.
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6. Place the product on its side with the ink tank on the bottom.

Warning: Be careful not to trap your fingers under the product.

7. Use a soft, moist cloth to clean the paper rollers, as shown. Rotate the rollers to clean them
thoroughly.

8. Return the product to its normal position.

Caution: Do not leave the product on its side for an extended period of time.

9. Replace the paper, slide in the paper cassette, and connect the power cord and any interface
cables.
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Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to store your product or transport it some distance, prepare it for transportation as described
here.
Caution: During transportation and storage, follow these guidelines:
• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

• Do not lift the product by gripping the scanner unit. Make sure you lift using the handholds on the
bottom of the product.
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• When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not
subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle
is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take
measures to prevent ink from leaking when transporting the ink bottles.

• Do not put opened ink bottles in the box with the product.
• Do not carry the product by its control panel; this may damage the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.
2. Open the printer cover and check to see if the print head is in the far right position (the home

position). If not, turn on the product, wait for the print head to move to the far right, then turn the
product off again.

3. Secure the print head to the case with tape.

Caution: Do not place tape on the white flat cable or ink tubes inside the product; otherwise, you
may damage your product.

4. Remove all the paper from the product.
5. Unplug the power cable.
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6. Disconnect any connected cables.
7. Open the ink tank cover and make sure that the ink tank cap is installed securely.

8. Close the ink tank cover.
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9. Insert the accessory box that came with the printer with the flap facing the front as shown below.

10. Place the product in a plastic bag.
11. Place the product in its original packaging materials, if possible, or use equivalent cushioning around

the product.
Be sure to remove the tape from the print head before turning on your product. If print quality has
declined when you print again, clean and align the print head.
Parent topic: Cleaning and Transporting Your Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Product Status Messages
Message Appears Prompting You to Reset the Ink Level
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Uninstall Your Product Software
Where to Get Help

Product Status Messages
You can often diagnose problems with your product by checking the messages on its LCD screen.

LCD code Condition/solution
(E-01) A printer error has occurred. Turn the product off and back on again. If the error

continues, check for a paper jam. If there is no paper jam, contact Epson for support.
(E-02) A scanner error has occurred. Turn the product off and back on again.
(W-01) Paper is jammed in the product. Remove the jammed paper, then press the button

indicated on the LCD screen to clear the error. If the error continues, turn the product
off and back on again.

(I-41) The Paper Setup Auto Display option is disabled. You must enable Paper Setup
Auto Display to use certain features.

Recovery Mode A firmware update has failed. Try updating the firmware again. If you still receive this
error message, contact Epson for support.



137

Parent topic: Solving Problems
Related references
Where to Get Help
Related tasks
Checking for Software Updates
Related topics
Solving Paper Problems

Message Appears Prompting You to Reset the Ink Level
If you see a message on the LCD screen prompting you to reset the ink level, do the following:
1. Refill the ink tank all the way to the upper line.

Note: Depending on the operating conditions, you may see the ink reset message even when there is
still ink in the tank.

2. Follow the instructions on the LCD screen to reset the ink level.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling
the ink tank correctly. The product cannot directly measure the ink level in the tank; instead it estimates
the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate
inaccurate messages if the ink tank is not refilled according to these instructions.
As a precaution, perform regular visual inspections of the ink tank to ensure the ink level does not fall
below the lower line. Continued use of the product when the ink level is below the lower line on the tank
could damage the product.

Parent topic: Solving Problems

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
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4. Select Maintenance and press the OK button.

5. Select Nozzle Check and press the OK button.

6. Press the start button.
The nozzle check pattern is printed.

7. Do one of the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
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settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the product may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.
Parent topic: Solving Problems
Related concepts
Uninstall Your Product Software
Print Head Cleaning
Print Head Alignment
Related references
Where to Get Help

Resetting Control Panel Defaults
If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings and press the OK button.
3. Select Restore Default Settings and press the OK button.
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4. Select one of these options:
• Copy Settings: Resets all copy settings.
• Clear All Data and Settings: Resets all settings.
You see a confirmation screen.

5. Press the OK button to reset the selected settings. (Press the stop button if you want to cancel the
operation.)

Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Noise After Filling the Ink
Software Installation Problems
Parent topic: Solving Problems

Noise After Filling the Ink
If you hear noises from your product after filling the ink tank with ink, check these solutions:
• The first time you fill the tank with ink, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished,
turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in
progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and any necessary cables are securely connected at both ends. If

you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.
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• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

Parent topic: Solving Setup Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Solving Copying Problems
Check these solutions if you have problems copying with your product.
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product

software is installed correctly.
• Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems
Related concepts
Print Head Cleaning
Print Head Alignment

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems
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Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
Paper Jam Problems in the Front of the Product
Paper Jam Problems Inside the Product
Paper Jam Problems in the Rear Cover
Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust

the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette. Make sure to load only one sheet at a time in the rear feed slot.

• Place the product on a flat surface and operate it in the recommended environmental conditions.
• Be sure to insert the paper cassette all the way into your product.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• Do not load more than the recommended number of sheets.
• Make sure your paper meets the specifications for your product.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure the paper size and paper type settings are correct for the paper source.
• Run the paper guide cleaning utility to clean the paper roller.
• Clean the roller inside the printer to remove any dust on the paper path.
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the cassette printable side down.
• Do not load binder paper with holes in the cassette.
• Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems
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Related references
Paper Jam Problems Inside the Product
Paper Loading Capacity
Related tasks
Loading Paper in the Rear Paper Feed
Loading Paper in the Cassette
Selecting the Paper Settings - Control Panel
Cleaning the Paper Guide

Paper Jam Problems in the Front of the Product
If you see a message that paper has jammed in the front of the product, follow the steps here.
1. Cancel the print job, if necessary.
2. Open the front cover.
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3. Lower the output selector.

4. Remove any jammed paper from the front of the printer.

5. Raise the output selector.
6. Close the front cover.
7. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
Parent topic: Solving Paper Problems
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Paper Jam Problems Inside the Product
If you see a message that paper has jammed inside the product, follow the steps here.

Warning: Never touch the buttons on the control panel while your hand is inside the product. If the
product starts operating, it may cause an injury. Do not touch any protruding parts inside the product.

1. Cancel the print job, if necessary.
2. Lift the printer cover until it clicks into place and remove any jammed paper inside.
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Caution: Do not touch the flat white cable or translucent film inside the printer.

3. Close the printer cover.

4. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Paper Jam Problems in the Rear Cover
If you see a message that paper has jammed in the rear cover, follow the steps here.
1. Cancel the print job, if necessary.
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2. Press the buttons to release the rear cover and remove the cover from your product. Carefully remove
any jammed paper from inside the product.

3. Remove any jammed paper from the rear cover.

4. Press the buttons and reattach the rear cover.
5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.
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Parent topic: Solving Paper Problems

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper falls from the output tray, extend the paper stopper.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems in the Front of the Product
Paper Jam Problems Inside the Product
Paper Jam Problems in the Rear Cover
Paper or Media Type Settings - Printing Software
Related tasks
Selecting the Paper Settings - Control Panel

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.
Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on and connected to your computer.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
• Make sure the printer status is not offline or pending.
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• Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

• Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. Print the image at a lower
resolution or if necessary, increase your system's memory.

• In Windows, make sure your product is selected as the default printer and the printer port setting
matches the printer connection port.

• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

• On a Mac, make sure the printer is added to the printer list and the printer is not paused.
Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
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6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
• On a Mac, make sure you download and install the Epson printer driver.
• Make sure Quiet Mode is turned off.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,

and select the following settings:
• Always Spool RAW Datatype
• Page Rendering Mode
• Print as Bitmap

• Windows: Select Printer Properties, click the More Options tab, and make sure the High Speed
setting is enabled.

• Mac: Select System Preferences, select Printers & Scanners, and select your product. Select
Options & Supplies, select Options (or Driver), and enable the High Speed Printing setting.
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If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.

Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.
Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
Mac System Requirements
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems
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Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software, if available.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
• You may need to refill the ink. Visually check the ink level.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check
Related references
Paper or Media Type Settings - Printing Software
Paper or Media Type Settings - Control Panel
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Related tasks
Loading Paper in the Cassette

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.
• Clean the scanner glass and the document cover. If there is dust or stains on the glass, the copy area

may extend to include the dust or stains.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Mac
Selecting Basic Print Settings - Windows
Selecting Page Setup Settings - Mac
Loading Paper in the Rear Paper Feed
Loading Paper in the Cassette

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in

the printer settings window, and cancel any stalled print jobs.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If your computer entered sleep mode the last time you printed, the next print job after your computer

exits sleep mode may contain garbled characters. Print your document again.
• If incorrect characters still appear in your prints, try connecting your product using a different cable.
• Make sure you are using the printer software for this product. Check the product name at the top of the

driver window.
Parent topic: Solving Page Layout and Content Problems
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Related tasks
Selecting Basic Print Settings - Mac
Selecting Basic Print Settings - Windows
Selecting Page Setup Settings - Mac

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure you selected the correct paper size on the control panel.
• Make sure your paper is positioned correctly for feeding into the printer.
• Clean the scanner glass and document cover.
• If the edges of a copy are cropped, slightly move the original away from the edges of the scanner

glass.
• Make sure you selected the correct margins for your paper size in your printing program.
• Be sure to select the correct Original Size setting for your original in the Copy settings.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Mac
Selecting Basic Print Settings - Windows
Selecting Page Setup Settings - Mac
Loading Paper in the Rear Paper Feed
Loading Paper in the Cassette

Slanted Printout
If your printouts are slanted, try these solutions:
• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
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• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Mac
Selecting Basic Print Settings - Windows
Loading Paper in the Rear Paper Feed
Loading Paper in the Cassette

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.
White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head.
• Adjust the print quality in the product software.
• You may need to refill the ink. Visually check the ink level.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.
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Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check
Print Head Alignment
Power Cleaning
Related references
Paper or Media Type Settings - Printing Software
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac
Refilling the Ink Tank
Loading Paper in the Rear Paper Feed
Loading Paper in the Cassette

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Remove each sheet from the output tray as it is printed.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the density and/or ink drying time settings.

• If printed copies are smeared, lower the copy density setting on the product control panel.
• The ink level may be low and you may need to refill the ink. Visually check the ink level.
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• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
• If you printed when the ink level was too low to be seen in the ink tank window, refill the ink tank to the

upper line and run the Power Cleaning utility. Then run a nozzle check to see if print quality has
improved.

• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check
Print Head Alignment
Related references
Paper Specifications
Compatible Epson Papers
Related tasks
Selecting Basic Print Settings - Mac
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac
Selecting Extended Settings - Windows
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Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink level may be low. Visually check the ink level.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check
Print Head Alignment
Related references
Paper or Media Type Settings - Printing Software
Paper or Media Type Settings - Control Panel
Related tasks
Cleaning the Paper Guide
Refilling the Ink Tank
Loading Paper in the Cassette

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
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• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

• Align the print head.
• Adjust the print quality in the product software.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Nozzle Check
Print Head Alignment
Related tasks
Selecting Basic Print Settings - Mac
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Parent topic: Solving Problems
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Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, make sure your product is listed as a valid device in the Scanners and Cameras control

panel.
Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart Epson Scan 2.
• Check the connection setting and test the connection using Epson Scan 2 Utility:

Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure the correct product is
selected. If necessary, select the Other tab and click Reset.
Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct
product is selected. If necessary, select the Other tab and click Reset.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson Scan
2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other
tab and click Reset.
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Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure the correct product is selected. If necessary, select the Other tab and click Reset.

• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both
versions and install one version.

• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
Parent topic: Solving Scanning Problems
Related topics
Starting a Scan

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.
Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
Image is Distorted or Blurry
Image Colors are Patchy at the Edges
Image is Too Dark
Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image
Scanned Image Colors Do Not Match Original Colors
Scanned Image Edges are Cropped
Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
• Make sure you placed your original for scanning facing the correct way.
• If the Image Type setting is Black & White, adjust the Threshold and scan again.
Parent topic: Solving Scanned Image Quality Problems
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Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, try these solutions:
• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the

cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

• Make sure any interface cables are securely connected at both ends.
Parent topic: Solving Scanned Image Quality Problems

Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Placing Originals on the Scanner Glass

Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:
• Do not move your original or your product during scanning.
• Your product will not operate properly while tilted at an angle. Place your product on a flat, stable

surface that extends beyond its base in all directions.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Increase the Resolution setting.
• If the Image Type setting is Black & White, adjust the Threshold setting.
• If the Image Type setting is Color or Grayscale, select the Unsharp Mask setting.
• If the Image Type setting is Black & White, select Text Enhancement. If the Image Type setting is

Color or Grayscale, change the Text Enhancement setting to High.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
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Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.
Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark
If your scanned image is too dark, try these solutions:
• If the Image Type is set to Color or Grayscale, adjust the Brightness setting.
• Check the brightness and contrast settings of your computer monitor.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

Back of Original Image Appears in Scanned Image
If an image from the back of a thin original appears in your scanned image, try these solutions:
• Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the Advanced Settings tab and adjust the Brightness setting.
• If the Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to

Color or Grayscale, change the Text Enhancement setting to High.
Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:
• Select the Descreening setting.
• Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems
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Related references
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

Scanned Image Colors Do Not Match Original Colors
Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).
Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.
To adjust the colors in your scanned image, adjust these Epson Scan 2 settings (if available) and try
scanning again:
• If the Image Type setting is Color or Grayscale, adjust the Contrast setting.
• If the Image Type setting is Black & White or Grayscale, adjust the Color Enhance setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

Scanned Image Edges are Cropped
If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Placing Originals on the Scanner Glass

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac
Parent topic: Solving Problems
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Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

• Windows 10: Click and select (Settings) > Apps or System > Apps & features. Then
select the program you want to uninstall and select Uninstall.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:

• Windows 10/8.x: Select Epson Event Manager and click Uninstall.
• Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and

Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

5. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
• Windows 10: Select Epson Scan 2 and click Uninstall.
• Windows 8.x/Windows 7/Windows Vista: Select Epson Scan 2 and click Uninstall/Change.

6. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.
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Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com.jm/support and select your product.
2. Click Downloads.
3. Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
4. Run the file you downloaded.
5. Double-click the Uninstaller icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to

uninstall.
7. Click Uninstall.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help
If you need additional help with your Epson product, contact Epson.
Epson provides these technical support services:

Internet Support
Visit Epson's support website at epson.com.jm/support for solutions to common problems. You can
download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your
questions.

https://epson.com.jm/Support/sl/s
https://epson.com.jm/Support/sl/s
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Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:

Country Telephone
Argentina (54 11) 5167-0300

0800-288-37766
Bolivia* 800-100-116
Brazil State capitals and metropolitan areas: 3004-6627

Other areas: 0800-377-6627 / 0800-EPSONBR
Chile (56 2) 2484-3400
Colombia Bogota: (57 1) 592-2200

Other cities: 018000-915235
Costa Rica 800-377-6627
Dominican Republic* 1-888-760-0068
Ecuador* 1-800-000-044
El Salvador* 800-6570
Guatemala* 1-800-835-0358
Mexico Mexico City: (52 55) 1323-2052

Other cities: 01-800-087-1080
Nicaragua* 00-1-800-226-0368
Panama* 00-800-052-1376
Paraguay 009-800-521-0019
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Country Telephone
Peru Lima: (51 1) 418-0210

Other cities: 0800-10-126
Uruguay 00040-5210067
Venezuela (58 212) 240-1111

* Contact your local phone company to call this toll-free number from a mobile phone.
If your country does not appear in the list, contact the sales office in the nearest country. Toll or long
distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest
reseller, visit epson.com.jm or call your nearest Epson sales office.
Parent topic: Solving Problems

https://epson.com.jm
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Technical Specifications
These sections list the technical specifications for your product.
Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Scanning Specifications
Ink Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows Server 2016
• Windows Server 2012 R2
• Windows Server 2012
• Windows Server 2008 R2
• Windows Server 2008
• Windows Server 2003 R2
• Windows Server 2003 SP2 or later
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Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com.jm/support, select your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• macOS 10.14.x
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com.jm/support, select your product, and select Downloads.

Parent topic: Technical Specifications

Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

https://epson.com.jm/Support/sl/s
https://epson.com.jm/Support/sl/s
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Single-sheets

Size A4 (8.3 × 11.7 inches [210 × 297 mm])
A6 (4.1 × 5.8 inches [105 × 148 mm])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 356 mm])
4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
8 × 10 inches (203 × 254 mm)
3.5 × 5 inches (89 × 127 mm)
16:9 wide (4 × 7.1 inches [102 × 181 mm])
Half Letter (5.5 × 8.5 inches [140 × 216 mm])

Paper types Plain paper

Note: Your product also supports compatible papers distributed by
Epson. See the link at the end of this topic for a list of compatible
Epson papers.

Weight Plain paper: 17 lb (64 g/m2) to 24 lb (90 g/m2)

Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Paper types Plain paper
Weight 20 lb (75 g/m2) to 24 lb (90 g/m2)

Parent topic: Technical Specifications
Related references
Compatible Epson Papers
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Printable Area Specifications
Single sheets

1 Top/bottom/left/right margins: 0.12 inch (3 mm) minimum
2 Reduced print quality area/top: 1.81 inches (46 mm) minimum
3 Reduced print quality area/bottom: 1.73 inches (44 mm) minimum

Envelopes
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1 Right/left margins: 0.12 inch (3 mm) minimum
2 Top/bottom margins: 0.20 inch (5 mm) minimum
3 Reduced print quality area/right: 0.95 inch (24 mm) minimum
4 Reduced print quality area/left: 1.81 inches (46 mm) minimum

Parent topic: Technical Specifications

Scanning Specifications
Scanner type Flatbed, color
Photoelectric device CIS
Effective pixels 10200 × 14040 pixels at 1200 dpi
Document size Maximum: 8.5 × 11.7 inches (216 × 297 mm)

Scanner glass: US letter or A4
Scanning resolution 1200 dpi (main scan)

2400 dpi (sub scan)
Output resolution 50 to 9600 dpi in 1 dpi increments)
Image data Color:

48 bits per pixel (16 bits per pixel per color) internal
24 bits per pixel (8 bits per pixel per color) external
Grayscale:
16 bits per pixel internal
8 bits per pixel external
Black and white:
16 bits per pixel internal
1 bit per pixel external

Light source LED

Parent topic: Technical Specifications
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Ink Specifications
Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not
specified for this printer could cause damage not covered by Epson's warranties.
The ink bottle that is used for initial product setup has a lower yield due to the ink charging process. This
process is carried out the first time you turn on the printer and guarantees better performance. Yields
vary considerably based on print jobs, print settings, paper type, frequency of use, and temperature. Do
not load paper before refilling the ink tank.
Check the ink level in your product frequently, and refill the ink tank if necessary.

Color Black
Ink bottle life Epson recommends using an ink bottle before the date printed on

the package
Temperature Storage: –4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)
Ink freezes at 5 °F (–15 °C)
Ink thaws and is usable after 2 hours at 77 °F (25 °C)

Parent topic: Technical Specifications
Related references
Ink Bottle and Maintenance Box Part Numbers

Dimension Specifications
Height Stored: 11.9 inches (302 mm)

Printing: 11.9 inches (302 mm)
Width Stored: 14.8 inches (375 mm)

Printing: 14.8 inches (375 mm)
Depth Stored: 13.7 inches (347 mm)

Printing: 13.7 inches (347 mm)
Weight
(without ink and power cord)

Approximately 13.7 lb (6.2 kg)
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Parent topic: Technical Specifications

Electrical Specifications
Note: Check the label on the product for its voltage.

Power supply rating 100 to 240 V
Rated frequency range 50 to 60 Hz
Rated current 0.5 to 0.2 A
Power consumption Standalone copying: Approximately 13 W (ISO/IEC24712)

Ready mode: Approximately 5.0 W
Sleep mode: Approximately 0.7 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity
(without condensation)

Operating: 20 to 80% RH
Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type Hi-Speed USB (Device Class for computers)

Parent topic: Technical Specifications
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Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.
Important Safety Instructions
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.
General Product Safety Instructions
LCD Screen Safety Instructions
Parent topic: Notices

General Product Safety Instructions
• Be sure to follow all warnings and instructions marked on the product.
• Use only the type of power source indicated on the product's label.
• Use only the power cord that comes with the product. Use of another cord may cause fires or shock.

Do not use the cord with any other equipment.
• Make sure the AC power cord meets the relevant local safety standard.
• Place the product near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system

that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,

crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.

• If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.
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• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.
• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not

operate properly if it is tilted or at an angle.
• Allow space behind the product for the cables, and space above the product so that you can fully raise

the document cover.
• Leave enough space in front of the product for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place or store the product outdoors.
• Do not place the product near excessive heat sources or in direct sunlight.
• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the

case or insert objects through the slots.
• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers

or the base units of cordless telephones.
• When connecting the product to a computer or other device with a cable, ensure the correct

orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

• Do not sit or lean on the product. Do not place heavy objects on the product.
• Do not touch the flat white cable or ink tubes inside the product.
• Do not move the print head by hand; this may damage the product.
• Do not put your hand inside the product while it is printing.
• Do not spill liquid on the product or use the product with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may

cause fire.
• Do not press too hard on the scanner glass when placing originals.
• Do not open the scanner section while the product is copying, printing, scanning, or performing any

other functions.
• Be careful not to trap your fingers when closing the document cover or printer cover.
• Except as specifically explained in your documentation, do not attempt to service or disassemble the

product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if

the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
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or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

• Before transporting the product, make sure that the print head is in the home (far right) position.
• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;

otherwise, ink may leak.
Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash

them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

• Do not press too hard on the LCD screen or subject it to heavy impacts.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson

for support.
Parent topic: Important Safety Instructions

Binding Arbitration and Class Waiver
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS
1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
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OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.
1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way,
Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.
1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at https://www.jamsadr.com/about/ or
by calling +1-949-224-1810 (from outside the U.S.) or 1-800-352-5267 (from within the U.S.), and under
the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and
both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The
arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court
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or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the
interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or
any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the
arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP
Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be
empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator
may award you the same damages as a court could, and may award declaratory or injunctive relief only
in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted
by that party's individual claim. In some instances, the costs of arbitration can exceed the costs of
litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator's award
is binding and may be entered as a judgment in any court of competent jurisdiction.
You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.
a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").
(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.
b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.
c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.
d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).
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e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.
1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
Parent topic: Notices

Trademarks
EPSON® is a registered trademark and EPSON Exceed Your Vision is a registered logomark of Seiko
Epson Corporation.
Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.
Apple, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.
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General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Copyright Attribution
Parent topic: Notices
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Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (I) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Copyright Attribution
© 2019 Epson America, Inc.
5/19
CPD-56129R1
Parent topic: Copyright Notice
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